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President’s Message —
Will There Be a Job for Me When I Get Out of School?

By Sheri Turner Gray, CSR 7350
CCRA President

During all the budget woes and Court Reporter Board crisis, CCRA has received many inquiries
and expressions of concern from court reporting students and teachers. The following is an open
letter to students and teachers both about my opinions of the viability of the reporting profession:

Dear Instructor,

Thank you so much for sharing your students’ concerns. We understand that students and
reporters alike have many concerns about the proposal to eliminate the CR Board. When the
proposal first came out and we first met with the Department of Consumer Affairs, it was not even
clear if they intended to keep licensing intact. The one concession at that meeting is that Director Lopez agreed
that there still needs to be licensing of reporters. The proposal to eliminate this and 16 other boards was not
made a part of the budget deal, and this matter now moves to the hearing process for further discussion.

CCRA'’s position is that the optimum situation would be for the Governor to take the CRB off the hit list and leave
it functioning as is, because it is working so well. We are truly hoping that our educating them on all the functions
that the board does and our letter-writing campaign will convince them to leave this particular board alone. In
the event that doesn’t happen, we will be working closely with the Board and the Department to work out some
plan whereby all of the functions of the board can be preserved. Any changes will require legislative action,
because the board and its authority are mandated legislatively. There will now be time for additional input through
the hearing process, and we are prepared to testify in that regard. In the meantime, we keep our ear to the
ground, our finger on the pulse, our representatives in their face, and stay prepared for whatever action we need
to take. Our lobbyist has daily communications on this issue with those who are in charge.

The reporting profession is not going away, and there is constantly a need for qualified, prepared reporters. | had
concerns about job security when | was in school 25 years ago. It is comforting to know that CCRA has been
around for 100 years, protecting and promoting our profession, and that California is the leader in the industry as
far as all the states are concerned, and that we have the most legislative protections in this state for reporters
than anywhere. We also have the largest and most complex judicial system, and the judiciary recognizes the need
for realtime reporters as crucial to their function.

It is also encouraging that in other states across the country where there has been a move to electronic recording,
they are bringing the reporters back. A live, stenographic reporter is the best way to capture and preserve the
record and provide the most advanced technological services to the attorneys and the court. The attorneys found
themselves hiring their own reporters to provide realtime or overnight transcripts, despite the fact that the
proceedings were being recorded by the court system. Also, be aware that in many states there is no licensing
of court reporters and no requirement to use a court reporter, yet the profession thrives anyway. Professional and
highly skilled reporters are always in demand.

The best thing that students can do now is to not be discouraged, to continue their hard work in school, focusing
on obtaining that all-important CSR license and then on becoming a certified realtime reporter. They can develop
professionalism and a good work ethic. They can stay informed and involved in the larger world of reporting and
the profession they will be entering when they graduate. They can join CCRA as a student member so we have
their support and contact information. They can be prepared for a further call to action, whatever that may be,
in our continuing efforts to protect and promote our profession.

Tell your students that if they do these things, there most certainly will be a job for them.
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The Changing Face of the Legal Industry

By Sheri Turner Gray, CSR 7350
CCRA President

Through all this recession, depression, economic
stress, whatever term you choose, the legal industry is
in the throes of woe just like everyone else. In my
many years of freelance reporting, | have seen
economic tough times come and go. And in the past,
usually when the economy goes south, the lawsuit
filings rise. | have not seen that trend in the last couple
of years as things have slowed down. And in the
litigation world, the economic situation seems like the
elephant in the room that no one wants to talk about.
The average reporter, | think, knows that it’s bad out
there generally, but do we really know how bad it is
and how it affects us? Folks in court reporting
agencies who attempt to sell services know these
stories very well, because they are right on the front
lines and in the trenches. Reporters look anxiously to
their firms to provide them with work, but with work
dwindling in many markets, these situations
affect every one of us.

If you subscribe to the National
Law Journal, you saw an
article on 2/13/09 on “Black
Thursday,” along with
some other headlines
om the past
couple of weeks
AN that are not very
encouraging,
that really lay
out in the
open what is
happening with
law firms. Six law
firms cut more
than 700 lawyers
and staffers on
“Black Thursday.”
The article says,
“If you were
among law firm
associates or
legal  staffers
who still had a
job by the end of
Thursday, consider

yourself lucky.” The link to read the full article is:
http://findcareersuccess.typepad.com/blog/2009/02/
black-thrusdaydisaster-or-opportunity.html.

All of the articles aren’t doom and gloom. But as
freelance reporters who are at the mercy of the
attorneys we work for, it might be time to really
evaluate the way we do business and provide
services. One young man commented, “However,
with so much fear and anxiety in the market, this is an
excellent time to take market share away from
competitors. And the flat-out best way to accomplish
this is to provide better service. Whether it pertains to
billing, adding services, or just anticipating your
clients’ needs better, this crazy market can represent
an unbelievable opportunity for you.” Provide better
service. What a concept.

Gone are the days of being able to pick and choose
the type of depo you want to take each day. Picky
reporters are reporters who probably sit home far
more often than they would like instead of working.
Don’t want to do an arbitration? Cover a two-day civil
trial? Do realtime hookup? | might not have a job for
you then. Highly skilled reporters with a great
professional attitude are always in demand. Do you
need to upgrade in any of these areas to be more
marketable?

And as much as we would like to and need to continue
to raise our prices to cover ever-growing overhead, |
do know law firms that have had to lower their hourly
rates to their clients. And let’s face it, depositions are
expensive for clients. The money has to come from
somewhere. Lawyers are scrutinizing their bills more
than ever before and wanting to make sure they get
the best value for the price, without sacrificing quality.
What | have talked to attorneys about and what | am
experiencing in my work are these changes: In “the
olden days” there were always a certain number of
depos automatically taken in a civil case, at least the
plaintiff(s) and defendant(s), before anyone started
talking settlement. Now cases are going to mediation
or mandatory settlement conferences without a stitch
of discovery being done beforehand. When it is clear
that the case will not settle and will inevitably go to

continued on Page 6
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The Changing Face of the Legal Industry

(continued from Page 5)

trial, THEN they notice the depos. So what | am
seeing is fewer depos taken, but the ones that are
taken seem to be more important, more critical, more
are being videotaped, and the transcripts are
expedited because they are on the eve of trial. More
stress for everyone.

In my opinion, the key to remaining viable and relevant
in our job is to be sensitive to the changes in the legal
industry. Be sensitive to the attorneys and the added
stresses they have. Adapt the way we do business to
be more helpful, more indispensible, more vital to the

judicial process. Be ateam player as much as we can,
within the parameters of our position as independent
and impartial officers of the court. And most of all,
have a good attitude. When things are stressful, the
last thing everyone wants in the room is a cranky
reporter. Realize what is going on out there, how it
affects us as reporters, the firms we work for, and our
clients, and do the best we can to help rather than
hinder the situation.

And hang on to the hope that “this too shall pass.”

ELECTRONIC COURT REPORTERS NOT AN
IMMEDIATE SOLUTION TO CUT COURT COSTS

Monday, February 23, 2009, 8:47 AM
By Darwin Danielson

It doesn’t look like electronic recording devices will
replace live court reporters in lowa’s judicial system
anytime soon. The idea is being discussed as a
potential for saving money. The Chief Justice of the
lowa Supreme Court, Marsha Ternus, says there are
no plans in this or the next budget year to try and
make a switch.

Ternus says replacing court reporters with digital
recording would be a “very complex” transition that
could not be done overnight,
and not something they
would do without a study of
judges and lawyers who
would be directly impacted.

Ternus says the switch is not something that would
lead to immediate savings.

Ternus says even if they felt it was the right thing to
do, it could not be implemented soon enough to
impact the court system budget. Ternus says they
will continue gathering information on the idea
before making any decision on making a switch.
She says they do plan to investigate the reliability
and accuracy of the technology. Ternus says they
also will study how they would meet
the needs of the judges for clerical
support and courtroom assistance
if they did make a switch to digital
recording for the official court
record.

The executive director of the lowa
Court Reporters Association says
they are worried about losing the
185 full-time court reporter jobs,
and whether the electronic
recorders would be able to
“maintain the integrity of the
record.”




Ask Mr. Modem! — www.MrModem.com

Modem

(,www.Mr*Mndem.net:
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Prevent Scrolling Excel Headings

Q. | am building a large Excel address file and |
want to know how | can make the column
headings (Name, Address, Email, etc.) appear
on each page. Right now they only appear on
the first page. Also, isn’t there also some way
to keep the column headings visible, so they
never scroll off the screen? Thanks, Mr. M.

A. Click File > Page Setup, and go to the Sheet tab.
In the “Rows to Repeat at Top” field, enter 1:1,
assuming your column headings are in Row 1,
and click OK. This will ensure that Row 1 is at
the top of every printed page.

To keep your headings visible (again, assuming
your headings appear in Row 1), click to select
cell A2 (yes, A2, not A1), then click Window >
Freeze Panes. Once selected, you can scroll
through your spreadsheet and your column
headings will remain within view at all times.

Q. How can | select the file types that my
Windows Media Player will play?

A. Open Windows Media Player (WMP) by going to
Start > Progarms > Windows Media Player. Click
Tools > Options > File Types tab. Select the
check box next to the file type(s) that you want
to open automatically using WMP, such as
WMA, WMV, .MP3, MIDI. If you want to use
WMP as your exclusive media player, click the
Select All button to choose all file types. Click
OK to save your changes and exit.

Q. When I visit Web sites using Internet Explorer,
a small screen pops up stating a line error
has been encountered. It asks if | want to

debug it. If | click the pop-up

“No,”
disappears, but it comes back. If | click “Yes,”
it goes to a debugging page of some type, but
I don’t know what to do from there. How can
I get rid of this?

A. If you disable the debugging function, you won’t
encounter those pesky pop-ups in the future.
The debugging function is intended for
programmers and developers, so by disabling it
you won'’t be adversely affecting your computing
life. To turn it off, click Tools > Internet Options >
Advanced. Scroll down to the Browsing section
and remove the check marks beside “Disable
script debugging (Internet Explorer),” “Disable
script debugging (Other),” and “Display a
notification about every script error.” Finish up
by clicking Apply > OK, close then reopen IE,
and you should be all set.

WANTED: Positive Customer Service Experiences

I’m working on an article about the ethereal concept
of customer service. Examples of abysmal service
abound, but if you have had an outstanding
experience with customer service — it need not be
related to computing or tech support — tell me about
it. Be sure to include the name of the company, what
your call (or email) concerned, and what you most
appreciated, or what most impressed you, about the
service you received.

Published submissions will be edited, so don’t be
concerned about grammar, punctuation or spelling.
If your submission is selected and approved for
publication, you will receive a copy of the published
work. (What, you were expecting cash?)
Please send vyour experience(s) to me at
MrModem@mrmodem.com. Thanks very much.

continued on Page 8
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(continued from Page 7)

Mr. Modem’s DME (Don’t Miss ‘Em)
Sites of the Month

Little Known Facts Show

This family-friendly site features short stories and
vignettes about Americana. The site includes fun
facts about American presidents, inventions, silly-
but-real laws, amusing town names, and trivia fans
without a life can read a new “Little Known Facts”
story every day. These stories are similar to Paul
Harvey’s world-renowned “The Rest of the Story”
feature. www.littleknownfactsshow.com

Plot-O-Matic

Have you ever sat in a movie theater, robotically
consuming a $27 tub of popcorn and thinking to
yourself, “I can write a better movie than this drivel”?
Judging from what’s passing for entertainment these
days, you probably could. In fact, it’s even easier than
you might think. Using the Plot-O-Matic (patent
pending), select your characters and the plot elements
you would like to include in your movie. When you’re
satisfied with your choices, click “Lights! Cameral!
Action!” http://tinyurl.com/6n42xd

Unusual Hotels

As its name implies, this is the place to turn if you’re
seeking non-traditional hotels. Perhaps you have
mole-like tendencies and would like to stay
underground, or inside an igloo, in a tree, or even
underwater? If so, you’ll find the opportunity here.
Categories include Art Galleries, Lighthouses,
Underground Caves, and even Prisons. Yes, for
$150/night you can stay in a fabulous Turkish Prison.
See, dreams do come true! Hotels are rated on a
scale ranging from “Different” to “Wow,” though I'm
surprised there isn't a “Get-me-out-of-here!”
category. www.unusualhotelsoftheworld.com/

For plain-English answers to your questions by email,
plus great computing tips, subscribe to Mr. Modem’s
award-winning newsletter. Subscribe using Promo
Code 4022 and receive two free months with your
12-month subscription (60 issues!) To view a sample
issue or subscribe, visit www.MrModem.com

il U Your vemid

Up to 1.8 CEUs
Technology
Realtime Intensive
StenoCAT 32 Training
and much more!

Realtins
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<~

StenoCAT Users Network Spring Annual Convention

March 26-28, 2009
Anaheim, California
Approved for up to 1.8 CEU's by NCRA and Texas CRCB
www.sughome.com or 800.357.7160
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Senator Joe Lieberman Questions
Federal Pacer Fees and Redaction of Information

WASHINGTON — Homeland Security and Governmental Affairs Committee Chairman Joe Lieberman,
ID-Conn., sent the following letter to the policy-making body of the Federal Court system requesting
proper compliance with the E-Government Act of 2002 on transparency and privacy issues as they relate
to court documents:

February 27, 2009

The Honorable Lee H. Rosenthal

Chair, Committee on Rules of Practice and Procedure
Judicial Conference of the United States

Washington, D.C. 20544

Dear Judge Rosenthal:

| am writing to inquire if the Court is complying with two key provisions of the E-Government Act of 2002 (P.L.
107-347) which were designed to increase public access to court records and protect the privacy of individuals’
personal information contained in those records.

As you know, court documents are electronically released through the Public Access to Court Electronic Records
(PACER) system, which currently charges $.08 a page for access. While charging for access was previously
required, Section 205(e) of the E-Government Act changed a provision of the Judicial Appropriation Act of 2002
(28 U.S.C. 1913 note) so that courts “may, to the extent necessary” instead of “shall” charge fees “for access to
information available through automatic data processing equipment.”

The goal of this provision, as was clearly stated in the Committee report that accompanied the Senate version
of the E-Government Act, was to increase free public access to these records. As the report stated: “[t]he
Committee intends to encourage the Judicial Conference to move from a fee structure in which electronic
docketing systems are supported primarily by user fees to a fee structure in which this information is
freely available to the greatest extent possible. ... Pursuant to existing law, users of PACER are charged fees
that are higher than the marginal cost of disseminating the information.”

Seven years after the passage of the E-Government Act, it appears that little has been done to make these
records freely available — with PACER charging a higher rate than 2002. Furthermore, the funds generated by
these fees are still well higher than the cost of dissemination, as the Judiciary Information Technology Fund had
a surplus of approximately $150 million in FY2006. Please explain whether the Judicial Conference is complying
with Section 205(e) of the E-Government Act, how PACER fees are determined, and whether the Judicial
Conference is only charging “to the extent necessary” for records using the PACER system.

In addition | have concerns that not enough has been done to protect personal information contained in
publicly available court filings, potentially violating another provision of the E-Government Act. A recent
investigation by Carl Malamud of the non-profit Public.Resource.org found numerous examples of personal data
not being redacted in these records. Given the sensitivity of this information and the potential for indentify theft or
worse, | would like the court to review the steps they take to ensure this information is protected and report to the
Committee on how this provision has been implemented as we work to increase public access to court records.

| thank you in advance for your time and | look forward to your response.
Sincerely,

Joseph I. Lieberman
Chairman

Page 9 : -
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AGAINST ER.

What has your vendor done for you?




Freelancers Stand United with

Our Official Associates to Fight ER/DR

By Lynden Glover

We continued the united front against
electronic/digital recording in the courtrooms of
California, and we won — one more time. | know for
some freelancers, the possibility of officials being
replaced by other means of obtaining a record
seems far removed from having an impact on
freelancers. Freelancers get caught up in the day-
to-day frenzy of traveling to a different location to
work every day, at different times, different
deadlines to keep track of, different preferences of
our clients to fulfill, and the stress of dwindling
calendars in these tough economic times. But we
freelancers understand very well how much tougher
it would be if the official reporters were forced to
seek work in the independent contractor world.

| believe it is also clear that if ER/DR were
implemented in the courtrooms, it would only be a
very short matter of time before freelancers working
in the public sector would experience the same fate.

The good news is having a live stenographer
manage and produce the record is still the most
efficient, accurate, and tamperproof means
available, and we have testimony and
documentation of the failings of ER/DR to prove it.
But we cannot let our guard down or let apathy get
the better of us. There is strength in numbers. And
with our diligent effort and the united front of all
stenographic reporters, we will continue to be
successful in our battle against ER/DR.

II!! PHILIP L. LIBERATORE, CPA

== A PROFESSIONAL CORPORATION

“We have saved hundreds
of court reporters thousands
of dollars and

Call or visit our website and find out why
our clients retum year after year

* Highest Professional Standards.
* Personalized Care.
* Ongoing Trusting Relationships.

562-404-7996

114-522-3337

www. liberatorecpa.com

we'll give you
the same
friendly,
professional
service”
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California Action Team Training

By Sandra Lynch, CSR, CRR, RMR

It all started with a message from my friend, Julie, asking
me if | had seen the contest that LACCRA was
sponsoring to win a trip to CCRA’s California Action Team
Training and encouraging me to enter. Thanks, Julie!

The next day | submitted my entry, answering the three
questions posed on the entry form. It had been a long
day at work, with some twists in the courtroom, which
made answering the question of why court reporters are
superior to digital recording very easy. Much to my utter
delight and surprise, | later learned | had won the contest
and was on my way to Sacramento, courtesy of
LACCRA.

Upon my arrival in Sacramento, | quickly realized this
wasn’t going to be your ordinary conference requiring
passive involvement. Saturday morning, various
speakers from Toastmasters International gave us tips
about public speaking, including body language, how to
answer questions effectively, how to dress for success.
This was a foreshadowing of the day ahead. Thanks for
getting me into this, Julie!

Saturday afternoon we heard from lobbyists Jim Cassie
and Michelle Castro. We learned about the California
State Legislature and how it operates. | realized what
warriors for court reporters Jim and Michelle are, day in
and day out. Thanks, Jim and Michelle!

We were split into groups on Saturday, and, at day’s end,
we were informed that the following day, our group would
be appearing in front of various mock entities, including
the formidable Administrative Office of the Courts, a
disinterested Republican Senator’s Chief of Staff,
and a Senate subcommittee. We had to be
prepared to argue against replacing court
reporters with digital recording in the
courtrooms and the Court’s
ownership  of  reporter’s
transcripts. Julie, what
kind of a friend are
you anyway?

Sunday dawned bright and early with a breakfast
meeting with my group. We were down one member due
to illness, so there were three of us left to play tag team
and present our arguments with precision. We had
practically memorized the two reports written by Chris
Crawford from Justice Served regarding the real cost
implications of both DR and State ownership of the
record. We knew the startling statistics of the error rate
in transcripts prepared from DR. We knew the three
states which had gone to DR and back to live reporters.
We felt as ready as we’d ever be.

On the way to our first appearance scheduled with a
managing partner of a law firm, we were practically
assaulted by a CNN “reporter” and cameraman who
stuck a microphone in our faces and asked about those
double-dipping court reporters. Julie, don’t ever call me
again.

| found myself answering the questions with surprising
ease. Double-dipping? Let me just give you a brief little
lesson, Ms. CNN Reporter. My fellow team members
chimed in seamlessly. We had sailed over our first hurdle
and | felt invigorated.

continued on Page 13




California Action Team Training

(continued from Page 12)

The rest of the morning was spent in 20-minute sessions
before the various mock entities, ending with an
appearance before a Senate subcommittee comprised
of:  “Senator” Tom Pringle; “Senator” Arnella Sims;
“Senator” Gary Cramer; “Senator” Lesia Mervin. While
these senators were really some of court reporting’s
greatest advocates, they played their roles of tough
critics with convincing realism. My palms were sweating
as | tried to calmly and succinctly answer their pointed
and sometimes facetious questions. My team members
brilliantly answered questions just at the right moment.

We walked out of the room feeling as if we’d just won the
Superbowl. We knew our stuff and we had nailed it!
Thanks team members Melanie Wilkins and Karen
Kronquest!

After lunch on Sunday, we were all given very helpful
critiques of our performances (note to self, NEVER
mention reelection to a senate subcommittee member.)
Sunday closed with an inspirational speaker who told us
how we are all leaders.

Today, one day later, | feel like a new woman. | am more
confident than | was when | left my home on Saturday
morning. | have new friends from all over California. |
have a renewed energy to continue the fight that surely
lies ahead to save this noble profession which has served
my family and me so well. Mostly, | have a deepened
gratitude to those who have given so tirelessly to educate
the public and promote and preserve court reporting.

Thank you, Julie!
Thank you, LACCRA, for making my attendance
possible!

Thank you, CCRA, for an educational and inspiring
experience!

Can’'t wait to see all of you at the 99th Annual
Convention, October 9-12, in Indian Wells to “rejuvenate
and educate.”

SHE SOUNDS LIKE A WINNER.
GET HER ON THE BOARD!

CCRA'S CALIFORNIA ACTION TEAM TRAINING
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California Action Team Training
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California Action Team Training
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Cal-e-licious \
By Gerie Bunch )

| took this to a beer tasting party and it was quite a hit!

Sausage Braid

For the filling: For crust:

4 green onions, chopped 1/4 c. cream cheese

6 lg. mushrooms sliced 1/4 c. butter (1/2 stick)

1 Ib. regular bulk sausage 2 c. baking mix

4 basil leaves, torn in bits 1/4 c. milk

3/4 c. dried cranberries 1/4 c. yogurt

Pepper to taste. Extra sour cream if needed

1 c. grated mozzarella

Cut cream cheese and butter into baking mix until crumbly; blend in milk, yogurt; add a dollop of
sour cream if dough is too dry. Turn onto a floured surface and knead for 1 minute. Roll out into a
12" x 8" rectangle and place on a well-greased cookie sheet.

Filling: Sauté onions and mushrooms over medium heat, about 3 minutes. Remove to a medium bowl
and add pepper and basil, toss and set aside. Sauté sausage until crumbly and no longer pink. Drain.

Spread sausage narrowly down the center of the dough, long ways; top with onion-mushroom
mixture and sprinkle with dried cranberries. Top with grated cheese. Cut protruding crust in 1 inch
strips from filling out, then lap over the filling one side then the other creating a braid. Bake @ 350
for 30 minutes until well browned. Cut in bite-sized pieces as an appetizer or large servings as a
breakfast entree.




Briefs Online

Looking for a quick brief for those hard to write words or common phrases? If you have a word or phrase that
you would like a brief form for, let me know, and | will publish your requested brief in the next CCRA Online. If
you have briefs that you would like to share with our members, please send them to Doreen Perkins,

CortReptri@aol.com or 1100 Van Ness, Dept. 50, Fresno, CA 93724-0002

If you find yourself assigned to Family Law you will enjoy these great briefs:

BRIEF FORMS AND PHRASES:

Alimony LOM Marital property MAERPT
Annulment NUMT Marriage MAIRJ
Biological BLAL Maternal MAERNL
Brother BRO Mediate DMAIT
Care, custody and control K-KD Mediation DMAIGS
Children KHIRN Mediator DMAIRT
Child support KHORT Minor child MOIRLD
Child support guidelines SGLINS Minor children MOIRN
Child support order KHORD Mother MOER
Child support payment KHORMT Order to show cause SHOERK
Conference K-FRNS Orientation OERNGS
Conference call K-FRK Parental PARNLT
Custody KUD or KUFT Paternal PARNL
Custody and visitation KUFGS Paternity PIRNT
Date of separation DRAIGS Readiness R*NS
Declaration DEL or DLAIRGS Reconciliation RILGS
Disposable income SPOIK Restraining order RO
Dissolution DOLGS Separation SPRAIGS
Dissolution of marriage DAIRJ Settlement agreement SGREMT
DissoMaster DMAFR Settlement conference SK-FRNS
Divorce DWOF Single-family SFAEM
Exchange KPAIJ Sister SIS
Exemption KPEJ or KPEMGS Sole custody SOID
Family Court Services FAEMSZ Sole legal custody SO*ILD
Family home FO*EM Spousal support SPORPT
Father FA Supervised visitation SPRIFGS
Furniture & furnishings F-FGS Supervised visits SPRIFS
Genetic GENT Temporary restraining order TRO
Grandfather GR-FR TRO TR*O
Grandmother GRAMD Visitation VIFGS
Grandparent GR-PT

Grandparents GR-PTS

Head of household HEFLD

Irreconcilable RAOIBL

Irreconcilable differences RAQOIBLDZ

Joint custody JOID

Joint legal custody JOILD

Jurisdiction JURD

Jurisdictional JURLD
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National Law Journal

Pamela A. MacLean, Staff Reporter
March 2, 2009

California courts may see cut hours, furloughed workers
New judges, probate reforms will be delayed.

In California’s budget crisis, the nation’s largest state
judiciary will be hit by severe budget shortages that
may prompt shortened court hours, furloughed
employees, loss of 50 new judgeships, and less
money for state-funded lawyers.

Even before the current budget crisis, Riverside
County, near Los Angeles, had too few judges to
handle its criminal caseload and imposed a
moratorium on civil trials.

That ended with the sending of a statewide judicial
swat team to pick up the slack, but the problem could
resurface there and in other counties, according to
William Vickrey, Administrative Director of the Courts.

The state’s trial courts, with more than 1,600 judges,
will face nearly $250 million in cuts from spending
based on reduced allocations for lawyers appointed
to represent dependent children, less money to cover
increased pay and health expenses, higher rents, and
increased costs for security officers.

For the second year, the judiciary must delay a $17
million allocation to reform the probate courts after
reports two years ago exposed corruption in handling
of some estates.

The judiciary budget was set at $3.84 billion for fiscal
year 2009-2010, which starts July 1, in the state’s $96
billion spending plan signed by the Governor Feb. 20.

‘Dire circumstances’

While the overall budget is roughly the same as last
year’s, that does not account for increases in pension
contributions due to poor investment performances.
higher rents, and existing wage increase
requirements, according to Vickrey.

“I think it is what could be achieved in these economic
times, which are dire,” said Judge Mary Wiss,

president of the California Judges Association and a
San Francisco trial judge.

California’s judicial branch fields nine million filings
annually, spread among more than 2,000 judicial
officers and 22,000 court employees in 500 buildings
spread around the state, according to the state
Administrative Office of the Courts.

This makes California the largest state court system in
the nation.

The state faced a $41 billion budget hole when
housing prices dropped, foreclosures soared, and
residents began losing jobs. The original 2008 budget
expenses of $103 billion had to be pared back to $92
billion, and the new budget for 2009 came in at $96
billion.

Although Judiciary branch employees, as an
independent branch of government, were spared the
furloughs imposed on other government offices,
nearly 50 of the 850 employees of the judiciary’s
administrative office agreed to voluntary furloughs of
one day a month as a cost saving measure, according
to the Administrative Office of the Courts.

“Courts may be open fewer hours. The irony is that in
economic downturns, the courts get more child-
support disputes, foster-care filings, and landlord-
tenant problems,” Vickrey said.

As recently as December, state Supreme Court Chief
Justice Ron George talked about a commitment from
Gov. Arnold Schwarzenegger to get 50 new judges on
the state’s 1,600-judge trial courts in 2009. But it now
appears the new judges are on hold.

The situation is increasingly dire in some parts of the
state. Riverside’s civil trial moratorium ended only
when visiting judges were brought in as a stopgap
measure. They continue to hold civil trials in closed

continued on Page 19
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National Law Journal

(continued from Page 18)

schools and other buildings to shorten the backlog
that had grown to four years, Vickrey said.

The trial courts face enormous pressures due to
population growth without a corresponding increase
in judges. Central Valley counties, such as Fresno,
Sacramento, and San Bernardino Counties, are likely
to be hit with the same problems that faced Riverside,
he said.

“When you look at the number of judges per 100,000
in population in other major urban states such as
Pennsylvania, Michigan, Florida and New York, then
California is at the bottom,” he said.

“We sent the team into Riverside, and some prisoners

had been sitting in prison four years waiting for their
cases to be tried,” he said.

Thank You, CCRA Members!

(

Here is a sampling of the many thank you letters
CCRA has received after the last budget victory.

Thank you, CCRA Members! We could not do any of
this without you!

= From: Rebecca Remsen
Awesome!! A Big thanks from this CCRA member and
court reporter.

=1 From: Stuart M. Simen

Just count this as one more win for our side as we
have been doing for the past 50 years. In one way we
must thank our ex-president Nixon for the 17 minutes
of lost tape, which is something that | have used over
and over again to explain to the public that tapes can
be erased very easily. Thanks to CCRA AGAIN for a
fight well fought.

= From: Carol S. Denny
Thank you, Mr. Cassie, for the fine work you have
done on our behalf.

“Criminal cases take priority and must be handled,
but when civil litigants can’t be heard, that is not fair
to them,” Wiss said.

The state is also hoping for $10 billion in federal
funds, but if the bailout falls short, an additional $900
million in cuts will be triggered. Vickrey said that will
include a $100 keep together million cut to the courts.
Most of it would pay for the new judges.

The bright spot is in courthouse construction.
Although the budget cut $40 billion out of court
construction, there will be 15 courthouses moving
ahead based on funding approved a year ago, he said.

He said the judiciary will start immediately to try to
negotiate for land or get it donated by counties and
begin design plans.

= From: Tamara Baron
Thank you for your hard work — and for keeping us
informed!!

= From: Julia Barton

Thank you to CCRA and Mr. Cassie because without
you making the Court Reporters aware that we need
to help, we wouldn’t get things done.

Thank you again.

=1 From: Linda Pugliese
Great work! Thank you for your efforts.
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In Memoriam — E. Kent Snyder, CSR 693

E. Kent Snyder, Kent Snyder to a lot of reporters in
Los Angeles, and Kent to the hundreds of reporters
who worked with him over the past many years.
Kent Snyder, California CSR 693, a gentleman who
took the first CSR exam in California, owner of
Snyder Heathcote Court Reporters in Los Angeles,
born December 7, 1921, passed away on Saturday,
February 7, 2009. Kent will be remembered by many
student reporters and new reporters for the classes
he used to conduct in his office during the evenings
where he taught new reporters and some still
students about the business of working in the real
world, the kind of education that you cannot receive
in school. Snyder Heathcote Court Reporters will
continue under the direction of Kent’s daughter Page
who for the past 30 years has worked at the firm.
The mantra of the firm will still be Kent’s favorite:
courtesy, consideration and communication.

Kent was a marine and fought in World War Il, and
after the war he came to California, he was a boy
from lowa, Strawberry Point, and he met his wife to
be before he went to war, and when he came back

he married Lynn and they were married for 60 years
before Lynn passed on. Kent never remarried. They
had two daughters, Page and Tina who both worked
in the firm. Kent had three grand children and one
great grand child at the time of his demise. This was
a sudden occurrence, and no one knew that this was
about to happen.

Kent was the gentleman of gentlemen, a
professional’s professional, and he would give you
the shirt off his back, and if he wasn’t wearing one,
he would go out and buy one for you.

Kent will be missed by his family and friends and
many reporters to whom he helped get through
rough spots, including trying to read through bad
notes with them. Though he was not a very active
reporter in reporting associations, he supported all
reporters in California and the United States with his
donations and his time. Kent didn’t know how to use
the word “no.” He would help out anyone in any
means that he could.




Who Am 1?

The following poem was written by
W.C. (Casey) Jones for the 1964 meeting of the Kansas Shorthand Reporters Association

“Who Am 1? My profession stems from man’s desire and his necessity to preserve the
happenings of yesterday and today for tomorrow. My profession was born with the rise of
civilization in ancient Greece. | was known as a scribe. | was in Judaea, Persia and the
Roman Empire before Christ. | preserved the Ten Commandments for posterity. | was with
King Solomon while building the Temple and recorded the origins of Masonry. My hand
labored upon the scroll that set forth the Bill of Rights wrested from the King of England at
Runnymede. | was with the founding fathers when the Declaration of Independence was
drafted. | witnessed the signature of John Hancock. | wrote the Dred Scott Decision for
Justice Taney. The immortal Abraham Lincoln entrusted me to record the Emancipation
Proclamation. | was commissioned to be with Roosevelt at Yalta. | was with Eisenhower on
D-Day; with MacArthur at Tokyo. | have kept confidence reposed with me by those in high
places as well as those in lowly positions. | protect the truthful witness, and | am a Nemesis

of the perjurer. | am a party to the administration of Justice under the law and the Court |
serve. | discharge my duties with devotion and honor. Perhaps | haven’t made history, but |

have preserved it through the ages for all mankind.”
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Sync Your Life Everywhere with Dropbox

Reprinted with permission from The 2.0 Life Web site

By David Pierce

® &
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Dropbox

I've talked about a couple of different backup services
before. After experiences I've had with losing data, | can’t
recommend highly enough finding a way to back up your
files.

The irritating thing about document backup is that it’s just
one more thing for you to remember to do — a web page
or application to launch, and a task you’ve always got to
have at the back of your mind.

The reason that’s great is that it’s integrated perfectly
into your normal workflow. Instead of uploading
documents to your backup service, just save them or
drag them into the Dropbox folder (which has replaced
my Documents as my default save location). They're
automatically uploaded to your account and are
accessible from anywhere. Every synced file gets a green
checkmark next to it, just so you can feel all warm and
snuggly knowing your files are safe with Dropbox.

Your files are always kept up to date by Dropbox, so
you’re sure to always have the most recent version of
your files available to you. If you’re on another computer,
with or without Dropbox installed, you can easily upload
and download those files for editing and viewing.

One cool thing that | don’t understand in the least, but is
enormously helpful: when you change a file that’s in your
Dropbox folder, Dropbox only uploads the part that was
changed: that saves you bandwidth and time, particularly
when you’re backing up large files.

Pictures can be viewed and shared from your Dropbox
account, making it your own personal photo-sharing tool.
You can also choose a subfolder within Dropbox to share
with others — perfect for collaborating or working with a

group.
Well, no longer.
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Sync Your Life Everywhere with Dropbox

(continued from Page 22)

Dropbox is multi-platform, so you’ll be able to use it
anywhere — Linux, Mac OS, Windows, or the Web. It’s
always in sync, and can essentially replace your
Documents folder on every computer you use.

Accounts are free, and you get 2GB of storage-perfect
for tons of Word documents and the like, but that fills up
fast when you’re sharing pictures or uploading
Photoshop documents. For $10 a month (admittedly a
lot), you get 50GB of space — also a lot.

Dropbox is the perfect solution for the person who can’t
be bothered to remember to back up their files, or put
them on their flash drive. Dropbox does it all for you,
and you can access and edit your files anywhere, from
any device.

David Pierce is a college student, freelance writer, and
lover of all things Web-based. He blogs about thriving in
a digital world at The 2.0 Life (www.the20life.com).
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How Can a Court Reporter Use Dropbox?

By Candis Bradshaw

Dropbox is a quick, easy, and painless way to
synchronize files and folders between multiple
computers. Here are a few ways court reporters can
use this powerful tool:

e Synchronize CAT user files between multiple
computers. Most reporters have at least two, if
not more, computers. Instead of manually
backing up files, such as your personal dictionary,
job lists/dictionaries, user settings files, macros,
and index templates, set Dropbox to
automatically sync the folders between
computers!

e Use Case Catalyst Work Units in conjunction
with Dropbox. If you have an expedited/daily
copy job, getting the audio and text files to your
scopist has never been easier. Share your
Dropbox folder with your scopist, then set Case
Catalyst to save the Work Unit files to your
Dropbox. You will never have to stop the
proceedings to upload another file to your scopist
again! Once your scopist completes the file,
he/she can put the completed file in your
Dropbox.

¢ Send jobs to your scopist in a snhap. Even if you
do not use Work Units, you can drop files for your
scopist into Dropbox. Once the file is uploaded,
your scopist will receive a pop-up notification that
a file has been uploaded, and the file will
automatically be downloaded to his/her
computer.

e Sync wordlists, job dictionaries, and fill-in
fields lists across an entire agency. Unlimited
people can share your files on Dropbox. So
synchronizing files between an entire agency, no
matter how small or large, is a shap.

¢ Upload files directly to Dropbox. If you are on a
computer that does not have the Dropbox client
installed, you can still upload and download files
from your Dropbox. Go to www.getdropbox.com,
log in, and voila, you can view files in your
Dropbox or upload new ones.

To share a folder on Dropbox:
1. Go to www.getdropbox.com and log in.

2. Click on Share at the top of the screen. Then
move down and select the folder you wish to
share.

»+ Dropbox

Honme Flhotos Slare AT LN

8 CRSA Documentation
3. Type invitee e-mail addresses in the Share This
Folder section on the right side of the screen
(under the Members section). Click the Invite

button when completed.

Share This Folder

= Preyvies lyile

The invitee(s) will receive this e-mail from Dropbox
with a link:

| shared some files with you using Dropbox — get
them here:

https://www.getdropbox.com/link/17.lcvi3YcFWd?k
=ab1234559601234abadasd

- (your name)

The invitee(s) must click on this link and create an
account (if they do not already have one) to view and
sync files. Once the invitee creates an account,
he/she can download the desktop Dropbox client.

Candis Bradshaw is a contributing editor for the JCR.
You can reach Candis at candisbradshaw@gmail.com.
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California Court Reporters Association
2009 CONVENTION

& EDUCATE

It's all about you!

Save the Date!

Join us for CCRA’s 99th Annual Conference at the

Miramonte Resort and Spa

Indian Wells, CA
Take a “Mini-vacation” October 9-12, 2009

Bring the Family
Earn CEUs
Network

Great Vendors
Relax

Beautiful Resort

LOW PRICES!

Conference Highlights

Friday, October 9 CCRA Golf Tournament (scramble format) at the
Indian Wells Golf Resort, home of the “The LG Skins Game.”

Friday, October 9 Evening Welcome Reception on the Piazza Terrace

overlooking the resort.

Saturday, October 10 Cocktail Party and Barbeque by the pool with live

entertainment followed by a reception in the Presidential Suite.

All weekend Spa, Relax and Rejuvenate!

California Court Reporters Assocation

Advancing our profession
for over 100 years. >4

Please contact the CCRA office for more information.
(949) 715-4682 ¢ www.cal-ccra.org * info@cal-ccra.org



Legislation Update

By Sandy Bunch VanderPol, CSR #3032

AB 5

AB 48

(Evans [D]) Civil discovery:

Electronic Discovery Act.

Status: 03/04/2009-From committee:

Do pass. To Consent Calendar. (March 3).
Current Location: 03/04/2009-A
CONSENT CALENDAR

Calendar Events: 03/10/09 6 ASM
CONSENT CALENDAR-SECOND
LEGISLATIVE DAY ASSEMBLY
MEASURES

Summary: The Civil Discovery Act permits a
party to a civil action to obtain discovery, as
specified, by inspecting documents, tangible
things, and land or other property in the
possession of any other party to the action.
Existing law requires the party to whom an
inspection demand has been directed to
respond separately to each item or category
of item by any of certain responses, including
a statement that the party will comply with
the particular demand for inspection by the
date set for inspection pursuant to a
specified provision. This bill would establish
procedures for a person to obtain discovery
of electronically stored information, as
defined, in addition to documents, tangible
things, and land or other property, in the
possession of any other party to the action.
This bill would permit discovery by the
means of copying, testing, or sampling, in
addition to inspection, of documents,
tangible things, land or other property, or
electronically stored information. This bill
contains other related provisions and other
existing laws.

(Portantino [D]) Private postsecondary
education: Dept. of Consumer Affairs
Status: 03/03/2009-In committee: Set,
first hearing. Hearing canceled at the
request of author.

Current Location: 02/05/2009-A HIGHER ED.
Calendar Events: 03/31/09 1:30 p.m. —
Room 437 ASM HIGHER EDUCATION

AB 170

Summary: This bill would express the intent
of the Legislature to enact legislation to
establish a Bureau for Private Postsecondary
Education and to encourage the Department
of Consumer Affairs to receive and respond
to student complaints and provide
information to students and prospective

students of private  postsecondary
educational institutions, until a Bureau for
Private Postsecondary Education s

established. The bill would continue the
existence of the Private Postsecondary and
Vocational Education Administration Fund
under the administration of the Department
of Consumer Affairs and would appropriate
$1,000,000 from that fund to the department
for the above purposes.

(Mendoza [D]) Court reporters: rough
draft transcript.

Status: 03/04/2009-Referred to Com.
on JUD.

Current Location: 03/04/2009-A JUD.
Calendar Events: 03/17/09 9 a.m. -
Room 4202 ASM JUDICIARY

Summary: Existing law provides that the
report of the official reporter or official reporter
pro tempore of any court, as specified, when
transcribed and certified as being a correct
transcript of the testimony and proceedings in
a case, is prima facie evidence of that
testimony and proceedings. Existing law
specifically provides that the report, when
prepared as a rough draft transcript, shall not
be certified and cannot be used, cited, or
transcribed as the official certified transcript of
the proceedings. Existing law also provides
that the rough draft transcript may not be
cited or used to rebut or contradict the official
certified transcript and that the production of
a rough draft transcript shall not be required.
This bill would provide, until January 1, 2017,
that the instant visual display of the testimony
or proceedings, or both, shall not be certified
and cannot be used, cited, distributed, or

continued on Page 27
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Legislation Update

(continued from Page 26)

AB 176

AB 250

transcribed as the official certified transcript of
the proceedings. The bill also would prohibit
the citation or use of the instant visual display
of the testimony or proceedings, or both, to
rebut or contradict the official certified
transcript of the proceedings.

(Silva [R]) Maintenance of the codes.
Status: 03/04/2009-Referred to Com.
on JUD

Current Location: 03/04/2009-A JUD.
Calendar Events: 03/17/09 9 a.m. —
Room 4202 ASM JUDICIARY

Summary: This bill would provide for minor
changes to Business & Professions Code
Section 8027, as relates to court reporting
schools, among other things. This bill is
proposed by the Law Revision Commission.

(Miller [R]) Criminal procedure:

trials: timing.

Status: 03/04/2009-Referred to Com. on
PUB. S. Deadline pursuant to Rule
61(b)(17). (Last location was DESK on
08/07/2008)

Current Location: 03/04/2009-A PUB. S.

Summary: Existing law requires that a
defendant be brought to trial within 60
days of arraignment in a felony case, as
specified. Under existing law, the case
must be dismissed if the defendant did not
waive that time limit or consent to an
extension of time, as specified, and the
case is not brought to trial within the time
limit. Under existing law, the defendant
may withdraw his or her waiver of time and
then the case is required to be brought to
trial within 60 days of the withdrawal of the
waiver. This bill would require the
withdrawal of the waiver to be done in
open court, as specified.

AB 484

AB 996

(Eng [D]) Franchise Tax Board:
professional or occupational licenses.
Status: 02/25/2009-From printer. May be
heard in committee March 27.

Current Location: 02/24/2009-A PRINT

Summary: The bill would require the
Franchise Tax Board, if an individual licensee
fails to pay taxes for which a notice of state
tax lien has been recorded, as specified, to
send a preliminary notice of suspension to the
licensee (including a CSR licensee). The bill
would provide that the license of a licensee
who fails to satisfy the unpaid taxes by a
certain date shall be automatically suspended,
except as specified, would require the
Franchise Tax Board to mail a notice of
suspension to the applicable state
governmental licensing entity and to the
licensee, and would provide that the
suspension be canceled upon compliance
with the tax obligation. The bill would require
the Franchise Tax Board to meet certain
requirements and would make related
changes. The bill would make implementation
of its provisions contingent upon
appropriation of funds for that purpose in the
annual Budget Act.

(Anderson [R]) Courts: continuous
hours of operation.

Status: 03/02/2009-Read first time.
Current Location: 02/27/2009-A PRINT

Summary: Existing law requires all offices
of every state agency to be kept open for
the transaction of business from 8 a.m.
until 5 p.m. of each day from Monday to
Friday, inclusive, other than legal holidays,
but provides that any state agency or
division, or branch or office thereof, may
be kept open for the transaction of
business on other hours and on other
days. This bill would authorize the Chief
Justice of the Supreme Court, the
presiding justice of a court of appeal, or

continued on Page 28
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AB 1040

AB 1168

the presiding judge of a superior court to
order the court to operate on a continuous
and ongoing basis, 24 hours per day, 7
days per week.

(Strickland, Audra [R]) Appeals: notice:
class action settlements.

Status: 03/02/2009-Read first time.
Current Location: 02/27/2009-A PRINT

Summary: Existing law provides that an
appeal is to the court of appeal, other than
in a limited civil case, and specifies certain
judgments and orders from which an
appeal may be taken. This bill would
require the appellant, upon filing a notice of
appeal, to state if the appeal is from a
lower court's approval of a class action
settlement. If so, then the appeal shall be
entitled to expedited briefing and
preference in setting the date for oral
argument within 120 days after the notice
of appeal has been filed.

(Carter [D]) Professions and vocations.
Status: 03/02/2009-Read first time.
Current Location: 02/27/2009-A PRINT

Summary: Existing law provides for the
licensure and regulation of various
professions and vocations by boards and
bureaus within the Department of
Consumer Affairs, and places the
department under the control of the
Director of Consumer Affairs. Existing law
authorizes the director to request specified
reports from these boards. This bill would
make nonsubstantive, technical changes
to that provision. (Could be a spot bill —
watch)

AB 1338

AB 1461

(Anderson [R]) Arraignment courts.
Status: 03/02/2009-Read first time.
Current Location: 02/27/2009-A PRINT

Summary: Existing law provides, when a
criminal complaint is filed, for the
arraignment of the defendant on those
charges before the court in which the
complaint is filed, as specified. This bill
would authorize the presiding judge of the
superior court, or a judge designated by the
presiding judge, together with the district
attorney and the public defender, to
establish and conduct an arraignment court
program. The bill would authorize the
presiding judge of the superior court to
establish extended hours for the operation
of an arraignment court program, and would
require the proceeds of any pecuniary
orders issued during those extended hours
to be distributed by the court among the
participating  prosecutorial,  defense,
probation, and arresting agencies.

(Ruskin [D]) Shorthand reporting.
Status: 03/02/2009-Read first time.
Current Location: 02/27/2009-A PRINT

Summary: Existing law provides for the
certification and regulation of shorthand
reporters by the Court Reporters Board of
California and makes a violation of these
provisions a crime. Existing law prohibits a
shorthand reporting corporation, as
defined, from doing or failing to do any act
that constitutes unprofessional conduct
under any statute, rule or regulation
pertaining to shorthand reporters or
shorthand reporting. This bill would
additionally prohibit a firm, partnership,
sole proprietorship, or other business
entity providing or arranging for shorthand
reporting services from doing or failing to
do any act that constitutes unprofessional
conduct under any statute, rule or
regulation pertaining to shorthand

continued on Page 29
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SB 377

SB 544

reporters or shorthand reporting. By
expanding the scope of a crime, the bill
would impose a state-mandated local
program. The California Constitution
requires the state to reimburse local
agencies and school districts for certain
costs mandated by the state. Statutory
provisions establish procedures for making
that reimbursement. This bill would provide
that no reimbursement is required by this
act for a specified reason.

(Corbett [D]) Courts: judgeships.
Status: 02/27/2009-From print. May be
acted upon on or after March 28.
Current Location: 02/26/2009-S PRINT

Summary: Existing law specifies the
number of judges for the superior court of
each county and for each division of each
district of the court of appeal. This bill
would, upon the Legislature’s appropriation
in the Budget Act of moneys expressly
identified for the purpose of initially funding
the costs of additional new judges,
authorize 50 additional judges, to be
allocated to the various superior courts
pursuant to uniform criteria approved by the
Judicial Council.

(Committee on Judiciary ) Civil law:
omnibus bill.

Status: 03/02/2009-Read first time.
Current Location: 02/27/2009-S PRINT

Summary: Existing law, the Civil Code, is
composed of 4 divisions relating to
persons, property, obligations, and general
provisions relating to persons, property,
and obligations. This bill would declare the
intent of the Legislature to enact technical
and noncontroversial statutory changes
relating to civil law..

SB 638 (Negrete McLeod [D]) Regulatory

boards: operations.
Status: 03/02/2009-Read first time.
Current Location: 02/27/2009-S PRINT

Summary: Existing law creates various
regulatory boards, as defined, within the
Department of Consumer Affairs, with
board members serving specified terms of
office. Existing law generally makes the
regulatory boards inoperative and repealed
on specified dates, unless those dates are
deleted or extended by subsequent
legislation, and subjects these boards that
are scheduled to become inoperative and
repealed as well as other boards in state
government, as specified, to review by the
Joint Committee on Boards, Commissions,
and Consumer Protection. Under existing
law, that committee, following a specified
procedure, recommends whether the
board should be continued or its functions
modified. The bill would authorize the
appropriate policy committees of the
Legislature to review the boards, bureaus,
or entities (including the Court Reporters
Board) that are scheduled to have their
board membership or bureau chief so
terminated or reviewed, as specified, and
would authorize the appropriate policy
committees of the Legislature to
investigate their operations and to hold
specified public hearings. The bill would
require a board, bureau, or entity, if their
annual report contains certain information,
to post it on its Internet Web site. The bill
would make other conforming changes.

For information concerning this report or the information contained herein, you may contact California
Court Reporters Association, Attn. Sandy Bunch VanderPol, CSR #3032, at 65 Enterprise, Aliso Viejo,
California 92656, (949) 715-4682 or by e-mail at RealtimeCSR@calweb.com.
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